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Software ( Network Configuration and Address Book Editor )

Operating Instructions
For Digital Imaging Systems

Before using this software, please read these instructions completely and keep these operating instructions in a safe place for 
future reference.

English
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The following trademarks and registered trademarks are used throughout this manual:

Microsoft, MS-DOS, Windows, Windows NT and Windows Server are either registered 
trademarks or trademarks of Microsoft Corporation in the USA and other countries.
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
i386, i486, Celeron, Intel Centrino and Pentium are trademarks of Intel Corporation.
The USB-IF Logos are trademarks of Universal Serial Bus Implementers Forum, Inc.
TrueType is a registered trademark of Apple Computer, Inc.
Novell, NetWare, IntranetWare, NDS are registered trademarks of Novell, Inc. in the USA and 
other countries.
PEERLESSPage™ is a trademark of the PEERLESS Systems Corporation; and,
PEERLESSPrint and Memory Reduction Technology® are registered trademarks PEERLESS
Systems Corporation; and, COPYRIGHT ©  2005 PEERLESS Systems Corporation.
COPYRIGHT ©  2005 Adobe Systems Incorporated. All Rights Reserved; and Adobe®

PostScript® 3™
Universal Font Scaling Technology (UFST) and all typefaces have been licensed from Agfa  
Monotype.
Agfa® and the Agfa rhombus are registered trademarks of Agfa-Gevaert N.V. registered in the 
U.S. Patent and Trademark Office and may be registered in other jurisdictions. Monotype® is a 
registered trademark of AMT registered in the U.S. Patent and Trademark Office and may be 
registered in other jurisdictions.
ColorTune® is a registered trademark of Agfa-Gevaert N.V. registered in the U.S. Patent and 
Trademark Office and may be registered in other jurisdictions. Profile Tool Kit™, Profile Studio™ 
and Profile Optimizer™ are trademarks of AMT and may be registered in certain jurisdictions.
PCL is a trademark of Hewlett-Packard Company.
Adobe, Acrobat, Adobe Reader, Adobe Type Manager, PostScript, PostScript 3 and Reader are 
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries.
All other product/brand names, trademarks or registered trademarks identified herein are the 
property of their respective owners.

©  2006 Panasonic Communications Co., Ltd. All Rights Reserved.
Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.
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The Network Configuration Editor uses the FTP protocol to edit settings for all functions in connected devices 
(printer, copier, scanner, or fax).
The Address Book Editor manages the IP addresses, telephone numbers, and similar settings for devices 
connected to the network (printer, copier, scanner, or fax).

 The Network Configuration Editor displays and edits device (printer, copier, scanner, or fax) settings.
 The Address Book Editor displays and edits device (printer, copier, scanner, or fax) address settings.

NOTE The Network Configuration Editor and Address Book Editor can be started from the device list in the 
Device Explorer / Network Device Locator.
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the FTP protocol. The desired device is first selected from the device list of the Device Explorer / Network Device 
Locator, and then the Network Configuration Editor, or Network Address Book Editor can be started.

Note:
The following screen is shown when retrieving the data from a device if the software modules have not been installed to your 
PC. Click the Update  button to download the modules from the Web site.

The compatible devices are listed in the Supported Models List.

Select Help  Supported Models... to open the list. You can access the Web site by clicking the Update  button on 
the window.
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System Requirements
Personal Computer : IBM PC/AT and compatibles (CPU Pentium II or greater is required, Pentium 4 or 

greater is recommended)

Operating System : Windows 98*1, Windows Me*2, Windows NT 4.0*3 (With Service Pack 3 or later is required), 
Windows 2000*4, Windows XP*5, Windows Server 2003*6

Interface : 10Base-T/100Base-TX Ethernet port

CD-ROM Drive : Used for installing the software and utilities from the CD-ROM.

Windows 2000, 
Windows XP, Windows NT 4.0, 
Windows Server 2003 : 256 MB or greater

*1 Microsoft® Windows® 98 operating system (hereafter Windows 98)
*2 Microsoft® Windows® Millennium Edition operating system (hereafter Windows Me)
*3 Microsoft® Windows NT® operating system Version 4.0 (hereafter Windows NT 4.0)
*4 Microsoft® Windows® 2000 operating system (hereafter Windows 2000)
*5 Microsoft® Windows® XP operating system (hereafter Windows XP)
*6 Microsoft® Windows Server ™ 2003 operating system (hereafter Windows Server 2003)

Free Disk Space : 200 MB or greater

Windows 98, Windows Me : 128 MB or greater
System Memory : The minimum recommended Memory for each OS is as follows:
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Opening Configuration /Address Book Editor
Start the Device Explorer by clicking the Start menu, and select All Programs  Panasonic 

 Panasonic Document Management System  Device Explorer. (i.e. Windows XP)

The Device Explorer opens.
Right-click on the device on the list, and then select either Network Configuration Editor, or Network 
Address Book Editor.

Your selection, the Network Configuration Editor, or Network Address Book Editor opens, and displays 
the retrieved data from the device.

 Opening from "Network Device Locator"
 In the "Tool menu"
 Select the device from the list, and click "Configuration Editor" icon to open 

"Network configuration Editor".
 Select the device from the list, and click "Address Book Editor" icon to open 

"Network Address Book Editor".
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Main Window
Network Configuration Editor

Help Bar Status Indicator

Network Address Book Editor

Help Bar Status Indicator

Help Bar : Input or operation guide help is indicated.

Status Indicator : Communication status and the latest communication results are indicated.

Menus and Icons

Menu
Toolbar 

Icon
Description

File
New Creates a new blank file.

Open Opens an existing file.

Close Closes the active file.

Save Saves the settings to a file with its current name.

Save As Saves the settings to a file with a new designated file name.

File Information Displays the device information, or used to edit the IP address list.

Font Selects the printing report(s) font.

Print Prints the active folder content.

Delete Deletes the file.

Export Exports the active folder contents to a text file.

Import Imports the active contents from a text file.

Exit Shuts down the application.

Quit Closes the active window without saving the data.
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Menu Toolbar 
Icon Description

Edit Cut Removes selected lines and places them on the clipboard.

Copy Copies selected lines to the clipboard.

Paste Pastes the contents of the clipboard at the insertion point of the line.

Insert Line Inserts a line at the insertion point of the line.

Delete Line Deletes a line at the deletion point of the line.

Find Parameter Searches for specified text in the active file.

Set to Default Sets all settings of the active folder to their default values.

View
List Mode Displays list mode.

Detail Mode Displays detail mode.

Sort Selects the display sort mode.

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Font Selects the display font.

Transfer
Retrieve Retrieves the current settings from the device.

Write
Writes the settings to the device.
Selects either "All Data" or "Department Codes" only.

Display Log Displays the transfer log.

Tools
Device Address List Opens the Device Address List dialog.

Device Group List Opens the Device Group List dialog.

Options  General Opens the General settings dialog.
Options  FTP 
Configuration

Opens the FTP Settings dialog.

Window
Tile Horizontal

Arranges and reduces all opened windows to fit into one window 
horizontally.

Tile Vertical
Arranges and reduces all opened windows to fit into one window 
vertically.

Cascade
Arranges all opened windows to overlap in a way that only the title 
bar of each window is visible.

Close All Closes all open windows.

Help Help Topics Displays Help Topics.

Supported Models Displays a list of supported models.

About
Displays the information about Network Configuration Editor / 
Network Address Book Editor.
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Basic Operation
Retrieve Data

When the Network Configuration Editor, or the Network Address Book Editor is started from the 
Device Explorer / Network Device Locator, it connects to the device, retrieves the data, and then displays it 
automatically.
The processing status is indicated in the bottom right side of the window.

Status Indicator

Note:
Data cannot be retrieved, if the device password was changed (Key Operator Code) from the default value.
If this happens, enter the Default Password in advance by clicking Tools  Options  FTP Configuration....

If you want to retrieve (refresh) the data from the device again, click the  icon, or select Retrieve from 
the Transfer menu.

Note:
While the device is operating (copying, printing, etc...), attempts to retrieve the data will generate a Retrieving error 
message. Try again later after the device goes into the standby condition.



Basic Operation
Edit Data

Network Configuration Editor

Modify parameters using the Network Configuration Editor.
When a function is chosen in the left pane of the window, the display on the right pane changes.

Note:
Fields on the left show what items have been changed.
*: An item which is different from the default setting.
#: An item that has been changed.

Network Address Book Editor

Modify, add, or delete Address Book entries using the Network Address Book Editor.
From the left pane window, choose the type of Address Book to view or use.
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Basic Operation
Write Data

If you want to record the edited data to the device, click the  icon, or select Write from the Transfer menu.

Select the Yes  button to start writing to the device.

Status Indicator

The processing status is indicated in the bottom right side of the window.

Note:
While the device is operating (copying, printing, etc...), attempts to write the data will generate a Writing error 
message. Try again later after the device goes into the standby condition.
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Advanced Operation
Save a Retrieved Data File

To save the retrieved configuration data, click the  icon, or select Save As from the File menu.

1. Select an existing file from the list, or enter a new file name.

2. Click the OK  button. The data is saved to a file.

To Save a File:
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Advanced Operation
Open a Saved File

To open a saved file, click the  icon, or select Open from the File menu.

To open a file:

1. Select a file from the list.

2. Click the OK  button.
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Advanced Operation
Create a New File

The editing window opens.
Edit the required items.

The Save As window opens.
Enter a new file name.

Click the OK  button.

The File Information window opens.
Click  to select the model number.
Enter the device name, location and IP Address 
of the device (optional).
Enter the login password (Key Operator Code) 
of the device (optional).

Click the OK  button.

To create a new file, for example to register an 
address book without connecting to the device, 
click the  icon, or select New from the File 
menu.
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Advanced Operation
Registering the Device Address List

To open the Device Address List, click the  icon.

Click the:

Acquires the network address list of the Device Explorer / Network Device Locator.

Discards all changes and closes the window.Cancel  button

Accepts the changes, and closes the window.OK  button

Connects and displays the retrieved data of the selected Device Address.Connect  button

Deletes the selected Device Address.Delete  button

Edits the current settings of the selected Device Address.Edit  button

Adds a new Device Address setting into the dialog box.Add  button

Acquire  button



19 U
si

ng
 C

on
fig

ur
at

io
n/

A
dd

re
ss

 B
oo

k 
Ed

ito
r

Advanced Operation
Registering the Device Group List

To open the Device Group List, click the  icon.

The Group Name List displays the registered groups.

Click the:

New  button Creates a new group.
Enters a name and click the OK  button.

Update  button Changes the name of the selected group.
Enters a new name and click the OK  button.

Delete  button Deletes the selected group.
The Device Address List displays the addresses of registered devices.

Acquire  button Acquires your network address list that the Device Explorer / 
Network Device Locator detected.

The Group Members section displays registered addresses for the selected group.
Use the   buttons to add, or delete the selected address from the group members.
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Advanced Operation
Using the Device Address List and Device Group List

The destination can be specified in the Address Book or Group List.

< Retrieving Data Message >

< Writing Data Message >

Destinations:
This options window shows the devices, and 
their IP addresses currently chosen.

Note:
Multiple destinations can be entered only when the 
Dept. Code is selected in the Transfer  Write 
menu.

Options...  button is shown when a writing option 
is available.

Manual Input tab:
Enter the device data manually, and then click 
the  button to add the address to 
the destination.

Device Address List tab:
The addresses registered in the Address List, 
and then Group List are shown.
Select an address, and add or delete it by 
clicking the Add  or  button.

Click the OK  button to return to the 
confirmation window.

The confirmation window appears before 
retrieving, or writing data.

Click the Change Dest.  button.
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Advanced Operation
Changing the Department Code Counter Data (Only for Network Configuration)

Follow the procedure below to write the Department Code Counter Data to the device.

Click the Options...  button.

Note:
Click the Options...  button, and then select Dept. 
Codes and Counter Data to write the Department 
Code Counter Data to the device.

Click the OK  button to return to the 
confirmation window.

Select Dept. Codes and Counter Data, and 

click the OK  button.

A confirmation window appears before writing 
data.

Click the Change Dest.  button.
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Advanced Operation
Using Timer Communication

Timer section:
Click Enable, and then select the time to start 
the communication.

Click the OK  button to create the job, 
and hold it in the spooler until the specified start 
time.

< Retrieving Data Message >

< Writing Data Message >

A confirmation window appears before 
retrieving, or writing data.

Click the Change Dest.  button.
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Advanced Operation
Cancel Timer Communication

If you need to cancel a job, select the job, and 
choose Delete from the Spooler menu.

Click the Spooler in the taskbar to open it.
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Advanced Operation
Editing the Network Address Book Editor – Copy and Paste Address Book data

Open the source data file, and the target data file.
Refer to Open a Saved File, see page 16.
Select Window  Tile Horizontal.

Select the range that you want to copy.

Click on the first number that you want to copy 
from, and then click on the last number that you 
want to copy to, while pressing Shift key.
or
Click on the first number that you want to copy 
from, and drag the mouse to the last number 
you want to copy to.

Right-click on the selection, and then select 
Copy, or select Copy from the Edit menu.

Click on the number where you want to paste 
the data.

Right-click and select Paste, or select Paste 
from the Edit menu.
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Data is pasted at the designated location.

Note:
The data exceeding the maximum allowable number 
of address book entries will be lost.
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Advanced Operation
Editing Network Address Book Editor – Import Address Book data from other 
applications

Address Book data created using other applications, such as Microsoft Excel®, can be imported.

Data is pasted at the designated location.

Note:
The data exceeding the maximum allowable Number 
of Address Book entries will be lost.

Click on the Number where you want to paste 
the data.
Right-click and select Paste, or select Paste 
from the Edit menu.

Copy the Address Book data from the other 
application.
The data format must be an Address (IP 
Address/Fax Number/Email Address), and 
Destination Name.
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PANASONIC DIGITAL DOCUMENT COMPANY MAKES NO WARRANTIES, GUARANTEES OR 
REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH RESPECT TO 
THIS PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC DIGITAL DOCUMENT COMPANY ASSUMES NO RISK AND SHALL NOT BE SUBJECT 
TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS SUSTAINED BY THE 
CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS PANASONIC MACHINE. SEE 
YOUR DEALER FOR DETAILS OF DEALER’S WARRANTY.

USA Only

WARRANTY

For Service, Call:

Panasonic Digital Document Company,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for
USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net/index.html

T0806-0(04)
PJQMC0412YA
August 2006
Published in Japan

http://panasonic.co.jp/pcc/en/
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http://panasonic.net/index.html
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